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1 Introduction

ProMove-V is the new-generation waterproof and dustproof wireless Inertial Measurement
Unit (IMU) of the ProMove series. Using Inertia’s high-speed and low-power wireless tech-
nology, a network of tens of ProMove-V’s can sample and stream all sensor data at high data
rates within 100 ns synchronization accuracy across all devices.

ProMove-V features a complete set of ultra-low-noise digital sensors, offering multi-modal
and multi-DoF (degrees of freedom) sensor data:

¢ 3-D low-range acceleration

3-D high-g acceleration

3-D turn rate / gyroscope

3-D magnetic field intensity / compass
e Barometric pressure (optional)
* GNSS (optional) for localization and tracking

The sensor data is transmitted wirelessly to a central node, the Inertia Gateway, which con-
nects to the computer through USB and acts as the master hub for data collection and sensor
configuration over-the-air. The Advanced version of the Inertia Gateway provides additional
features such as synchronized trigger and clock for external systems, as well as Raw Ethernet
data transfer support.

The number of devices in the network scales with the sampling rates: for example, a network
can have 39 nodes operating (sampling and communicating) at 200 Hz, 19 nodes operating at

Figure 1: ProMove-V sensor node
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500 Hz or 9 nodes operating at 1000 Hz.

ProMove-V is also equipped with at least 16 GB of internal storage. All sensor samples are
logged internally, in addition to being sent over-the-air. Any information lost during the wire-
less transmission can be recovered at the end of each measurement round.

The Inertia Studio software (freely available on our website) is the interface for visualizing
the incoming data in real-time and configuring all devices in the network and all sensors. Full
access to the raw sensor data is provided to the user, as well as 3-D orientation information,
expressed as quaternions and Euler angles. C++, Java and Android SDKs, along with examples,
are also available for integration with custom applications.

ProMove-V is carefully designed for good ergonomics. The curved design makes mounting and
wearing on body parts comfortable, without affecting stability in case of surface mounting.

Please read the safety instructions in Section 2 carefully. Information about warranty and lia-
bility can be found at: https://inertia-technology.com/terms-and-conditions/.
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2

Safety Instructions

To avoid a potential safety hazard, please follow the safety instructions below:

Do not exceed the maximum input voltage of 5V.

Only connect to CE-certified computers and USB-adapters.
Operate the product at temperatures between 0 and 35°C.
Do not charge the product if wet.

Once fully charged, remove the product from the charger.

Protect the product from violent handling, drops on hard surfaces, excessive shocks or
mechanical stress.

Do not open, crack, pinch or mutilate in any way the product.

Do not use the product if it appears damaged or tampered with in any way.

Do not attempt to replace the battery, open the enclosure or disassemble the product.
Turn off the product before entering an area with potentially explosive atmosphere.
Do not overheat the product by exposure to high temperatures or direct sunlight.

Do not dispose the product in fire.

Do not discard the product in the trash. Follow proper electronic and battery waste
disposal protocol, as dictated by local authorities.

Keep the product out of the reach of children.
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3 Setup

This section describes the high-level system setup.

3.1 System Description

The default system consists of a number of ProMove-V sensor nodes, the Advanced Inertia
Gateway and Inertia Studio (PC Software) for monitoring and logging the inertial data. The
sensor nodes communicate wirelessly with the gateway in the 2.4 GHz ISM band. The gateway
is connected through the mini-USB connector or the Ethernet connector with a PC that runs
Inertia Studio.

C++ and Java SDKs are available for developing custom applications that interact with Inertia
devices. The SDKs allow implementations on both desktop and mobile Android platforms.

Figure 2 shows the typical system setup with an USB connection between the Advanced Inertia
Gateway and the PC running Inertia Studio.

Computer with
Inertia Studio software

External system

(e.g.camera)
Clock signal

FLrirbL

_f
Trigger

ProMove-V sensor nodes

Figure 2: System setup with an USB connection
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Figure 3 shows the system setup with an Ethernet connection between the Advanced Inertia
Gateway and the PC running a custom application using Inertia SDK.

Computer with
custom application
using Inertia SDK

ETHERNET

External system

Advanced : (e.g.camera)
Inertia Gateway Clock signal
_f
Trigger

ProMove-V sensor nodes

Figure 3: System setup with an Ethernet connection

3.2 Node LEDs and Button

The LEDs and the multifunctional button are located on top of the ProMove-V sensor node, as
shown in Figure 4.

The green LED indicates the node is charging: it stays lit while the battery is charging and it
turns off when the battery is fully charged. If the green LED starts blinking during the process,
this indicates a faulty state and the node will not charge. See Section 7 about Troubleshooting
for more information.

The blue LED indicates the node is turned on and sampling data. The blinking rate is deter-
mined by the sampling rate. The number of blinks has the following meaning:

¢ Single blink: Not transmitting data.

¢ Double blink: Transmitting data via USB or wireless. Synchronized nodes should blink at
the same time.

inertia-technology.com Page 8 of 74
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Figure 4: The ProMove-V node top view with green and blue LEDs

¢ Five blinks: Logging to flash memory.
The button has the following functionality:
¢ Pressing short once: Turns the node on.
¢ Pressing short twice: Starts or stops logging to the flash memaory.

¢ Pressing long once: Turns the node off. Pressing more than 5 seconds forces the node
to shut down.

3.3 Gateway Front and Back Panes

Figure 5 shows the front and back of the Advanced Inertia Gateway. On the front, the gateway
has two BNC connectors and four blue LEDs with the following functionality:

¢ RX: The gateway is receiving data.

e TX: The gateway is transmitting data.

¢ Power: The gateway is powered on.

¢ Sync: The gateway is synchronized with an external signal.

The EXT SYNC 1 and EXT SYNC 2 connectors can be configured as Input or Output, with either
Trigger or Sync functionality. See Section 4.10 for more information.

The backside contains a DC power connector, antenna, mini-USB connector and an 100BASE-
TX Ethernet connector. The gateway can be connected using the mini-USB or the Ethernet
connector to the PC.

When using the Ethernet connector, the gateway can be connected directly to the network
adapter of the PC using an Ethernet cable, or to a (wireless) switch/router in the same local
network as the PC. Inertia Studio requires Npcap or WinPcap on Windows and libpcap on Linux
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and macOS to access the network adapter and receive the Raw Ethernet data. The gateway
has a local MAC address based on its serial number, e.g. 02:34:56:78:xx:xx, where xx:xx is the

serial number. The gateway sends its data to broadcast address ff:ff.ff.ff:ff:ff using EtherType
protocol Oxbabe.

ANTENNA e

Spplhglea Do 100BASE-TX

Figure 5: The front and back of the Advanced Inertia Gateway
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3.4 Attachments

Velcro straps of 40 cm in length are provided as part of the ProMove-V sensor kit. They can be
attached through the handles of the ProMove-V sensor node for mounting on body parts or
clothing, such as wrist, ankle or shoe, as shown in Figure 6.

p—

il

Figure 6: Examples of attaching the ProMove-V to the wrist and shoe

Attaching a velcro strap to the handles of ProMove-V sensor node can be done as described in
Figure 7.
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Figure 7: Attaching a velcro strap to ProMove-V
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3.5 Recharging the Batteries

The internal battery of the ProMove-V sensor node should be periodically recharged. This can
be done by using a cable connecting the USB-C connector of the sensor node to a computer
or a standard USB charger. It is recommended to power off the sensor node before charging.

Alternatively, a set of maximum ten ProMove-V sensor nodes can be charged by using the
ProMove-V charging cradle, see Figure 8.

Figure 8: ProMove-V charging cradle

To charge a set of ProMove-V sensor nodes using the charging cradle, follow the instructions
below (see also Figure 9):

1. Place each sensor node in a charging pad of the cradle, with the charging port pointing
towards the USB-C connector.

2. Slide the sensor nodes into the USB-C connector until complete insertion.
3. Connect the charging cradle to the AC/DC power supply using the 4-PIN connector.
4. Connect the power supply to the mains.

To remove a sensor node from the charging cradle, the node must be first disconnected from
the USB connector by pushing it away from the connector. After that, the sensor node can be
removed from the cradle pad. See Figure 10 for more information about removing a sensor
node.
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Place the sensorin Slide the sensor in The sensor is connected
the cradle pad. the USB connector. to the charger.

Figure 9: Inserting a ProMove-V sensor node into the charging cradle.

Slide the sensor off Grasp and lift Remove the sensor from
the USB connectoar. the sensor. the cradle pad.

Figure 10: Removing a ProMove-V sensor node from the charging cradle.

The incorrect removal of the sensor node while still plugged in the USB connector may cause
damage to the cradle or sensor node (see Figure 11).

>

Do NOT take out the sensor while
still plugged in the USB connector!

Figure 11: Incorrect removal of a ProMove-V sensor node from the charging cradle.

A fully drained battery takes approximately approximately 55 minutes to recharge. During
charging, the green LED of the ProMove-V node is on. Monitoring the battery voltage can be
done using Inertia Studio (see paragraph 4.1.3.2).

3.6 On-board Storage
ProMove-V sensor nodes are equipped with (at least) 16 GB flash memory.
The flash memory is used to store the following data:

¢ The sensor nodeevice configuration, including the global parameters, the wireless op-
tions and the configuration of the sensors (for information about changing, storing and
clearing the configuration, see Section 4.8).
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¢ The sensor data, the sampled data of all enabled sensors. More information about stor-
ing data in the flash memory of a sensor nodeevice can be found in Section 4.4.

3.7 Reference System Axes

Figure 12 shows a ProMove-V node and the reference system axes (X, Y and Z) to which the
on-board sensors are aligned.

f + Z axis
i
1
1
1

sy e

-_""---..,

s
»° +Xaxis

Figure 12: The ProMove-V node and the reference X, Y and Z-axis

inertia-technology.com Page 15 of 74


http://www.inertia-technology.com

3.8 Installing the Application

This section explains the installation of the Inertia Studio application on various operating sys-
tems. For information on performing an measurement with nexoDAQ, please see Section 6.

The Ineria Studio application runs under Windows, Linux and macOS operating systems. In the
following, we describe the installation procedure in each of these environments.

3.8.1 Windows

On a Microsoft Windows computer, unzip and run the Inertia Studio setup executable. During
the setup process, the Inertia driver and the Visual C++ redistributable are installed (Figure 13).
This may require a computer reboot. Choose a destination folder and press the Install button
(Figure 13).

A Inertia Studio 3.7.2 Setup = x X Inertia Studio 3.7.2 Setup = x
Choose Components Choose Install Location <
Choose which features of Inertia Studio 3.7.2 you want to install. ,ﬁ Choose the folder in which to install Inertia Studio 3.7.2. (‘&
Chedk the components you want to install and unchedk the components you don't want to Setup will install Inertia Studio 3.7.2in the following folder. To install in a different folder, dick
install. Click Next to continue. Browse and select another folder. Click Install to start the installation.

Select components to install: Inertia Studio

Inertia USB-Serial Driver
Wisual C++ Redistributable

Create Desktop Shortout Destination Folder

+| Create Start Menu Shortcut

C: \Program Files\Inertia Studio Browse...
Space required: 98.5 MB Space required: 98.5 MB

Space available: 53.8 GB

< Back Next > Cancel < Back Install Cancel

Figure 13: Inertia Studio installation in Windows

3.8.2 Linux

In Linux Ubuntu, install the package with the following command:
sudo dpkg -i inertiastudio-[version].deb
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3.8.3 macOS
On a macOS device, open the *.dmg file as follows:
¢ On an Apple silicon device, open the armé64 version of the *.dmg file.
¢ On an Intel device, open the version without armé64 in the *.dmg file name.

Afterwards, drag the Inertia Studio application to the Applications, as shown in Figure 14.

@ @ [C} inertiastudio-3.7.2-mac0S-arm64
e s
), 4
& ;
’
Applications InertiaStudio.app

) inertiastudio-3.7.2-macOS-arm& 4

Figure 14: Inertia Studio installation in macOS
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Inertia Studio can be used for realtime visualization of sensor data, logging of sensor measure-
ments and pre-computed orientation, and configuration of sensor and wireless parameters.
This section describes Inertia Studio (v3.7.3) in more detail.

Inertia Studio is available for Microsoft Windows, Ubuntu Linux and macOS.

Figure 15 shows the main screen of Inertia Studio, which is divided in the following areas:
e The menu and toolbar at the top (described in Section 4.1.1)
e The sensor data plots in the middle (described in Section 4.1.2)
¢ The information area at the bottom (described in Section 4.1.3)

In the following, these three areas are presented in detail.

7 Inertia Studio (x64) 3.6.2

File Configuration View Help

Acceleration X (m/s?)|
Acceleration Y (m/s?)
Acceleration Z (m/fs¥)

164:48 164:48 1 164:48
Time [mis) Time [mis) Time {mis)

Compass Y {gauss)
Compass Z (gauss)

Py
1
Fl
B

2

»
P
@
@
a
E
S

o

164:48 : 164:48
Time [m:s) Time [mus)

Gyroscope X (*/s}
Gyroscope Y (*/s)
Gyroscope Z (°/s)

164:48
Time [m:s) Time {m:s)
~ ~
Time Message NodelD Connection Loss Flash GNSS

~ 122518 Connected to Inertia Gat

Figure 15: Inertia Studio with six nodes, showing data from the accelerometer, compass and
gyroscope
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4,1.1 Toolbar and Menu

The toolbar is used to quickly access the most used functionality of Inertia Studio. This section
describes the default buttons of the toolbar, from left to right (see Figure 16).

Eile Configuration View Help

Connect Record Pause Sensor Settings  Preferences Hide Clear Layout Tracker ZoomIn  Zoom Out

o

Figure 16: Inertia Studio menu and toolbar

¢ Connect / Disconnect
The Connect / Disconnect button can be used to quickly connect to, or disconnect from an
Inertia device. The drop-down menu associated with this button opens a list for selecting
the target device. See Section 4.2 for more information.

e Record / Stop
When connected to a device, the Record / Stop button can be used to quickly start and
stop logging/recording to file (see Section 4.3). If timed recording is enabled, a small clock
overlay is shown on the icon. The drop-down menu associated with this button offers rapid
access to the Logging Configuration window (see Section 4.3). The user can also quickly set
the duration of the recording using time-presets.

e Pause / Resume
The Pause / Resume button is enabled when replaying a logfile. It can be used to pause and
resume the replay.

e Sensor Settings
The Sensor Settings button opens the Sensor Settings window (see Section 4.8).

¢ Preferences
The Preferences button opens the Preferences window (see paragraph 4.13.2.2).

¢ Hide / Show
The Hide / Show button toggles between hiding and showing the data in the plots. The
drop-down menu associated with this button opens a list for selecting the target nodes for
which the data is hidden or shown. An small sign (i.e. red cross or yellow triangle) on the
icon indicates that some data is hidden. This button does not influence the logging.

e Clear (F5)
The Clear button, or F5, clears the plots, legend and node lists. This button does not influ-
ence the logging.

¢ Layout
The Layout button opens the Layout Wizard (see Section 4.13.1) and has a drop-down menu
to switch between layouts.
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Tracker
The Tracker button opens the Tracker window (see Section 4.11).

Zoom In (F3) / Zoom out (F4)
The Zoom buttons, or F3 and F4, can be used to zoom the X-Axis of all plots in or out.

The menu allows access to all the options of Inertia Studio and has the following items:

File

—Connect opens the Connection Configuration window (Section 4.2).

—Record opens the Log to File (Section 4.3) and Log to Flash (Section 4.4.1) windows.
—Replay opens the Replay window (Section 4.7).

—Download opens the Download Logfiles window (Section 4.4.2).

—Fill-in Lost Samples opens the Fill Loss window (Section 4.5).

—Export opens the Export Logfiles window (Section 4.6).

—EXxit closes Inertia Studio.

Configuration

—Sensor Settings opens the Sensor Settings window (Section 4.8).

—1/0 Settings opens the I/0 Settings window (Section 4.10).

—Sensor Calibration opens the Calibration Configuration window (Section 4.9)..
—Preferences opens the Preferences window (paragraph 4.13.2.1).

—File Types opens a sub-menu to configure the supported file types.

—Power Down allows the user to remotely power down specific sensor nodes.

View

—Layout Wizard opens the Layout Wizard (Section 4.13.1).

—Tracker opens the Tracker window (Section 4.11).

—GNSS Map opens the GNSS Map window (Section 4.12).

—Detailed Status opens the Detailed Status window (paragraph 4.1.3.4).

—Toolbox can be used to show or hide the Zoom and Pan sliders and the Log and Legend in
the information area.

—Toolbar can be used to change the appearance of the toolbar. The toolbar can be hidden
using the Hide option. The size of the toolbar icons can be modified to Small, Medium and
Large. Show Text allows to show or hide the text below the icons. Show I/0 Buttons adds
two extra buttons to the toolbar for I/O functionality.

—Show Data toggles between showing and hiding the incoming data in the plots.

—Clear Plots (F5) clears the plots, legend and node lists.

—Full Screen (F11) shows Inertia Studio in full-screen mode.

Help

—Check for Updates checks if a new version of Inertia Studio is available, or if new firmware
for the connected nodes is available.

—Firmware Update opens the Firmware Update window (Section 4.14).
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—Software Web Site opens the Inertia Technology software website.
—Manual (F1) opens the Inertia Studio manual.
—About shows the current Inertia Studio version and build date.

4.1.2 Plots

Inertia Studio can be configured to display a customizable number of plots that show in real-
time the sensor data, status data (e.g. battery voltage, lost samples) and processed data (e.g.
orientation, Norm, FFT). The shown plots and layout can be customized via the Layout Wizard
(see Section 4.13.1). The X-axis of the time-plots represents the number of seconds since the
gateway was started.

The mouse can be used to zoom and pan the plot. Holding the left mouse button while moving
the mouse creates a zoom-box. Releasing the left mouse button zooms to the selected data.
Note that Auto-scaling resets the Y-axis zoom. A plot can be panned by holding the right mouse
button and moving the mouse. By default, the X-axis is automatically set to the latest received
data. Disable Show Data or use the pan slider (see Section 4.1.3) to prevent this.

Right-clicking on a plot provides the following options (see Figure 17):

Fit
Zoom In
Zoom Qut
Lock X-axis...
Lock Y-axis...

~ Auto-Scale Y-axis
Save as SVG...

Figure 17: Plot right-click pop-up menu

¢ Fit: Fits all received data in the plot.

e Zoom in/out: Zooms the plot in or out. The Zoom buttons in the toolbar and the Auto-
scaling option (see paragraph 4.13.2.2) can be used to reset the zoom.

e Lock X-axis...: Locks the X-axis to a specified range by showing a pop-up window in which
the minimum and/or maximum values of the X-axis can be set. When the axis is locked,
a < and/or — symbol is shown at the bottom right and/or left corner of the plot. This
option is only enabled for FFT plots.

e Lock Y-axis...: Locks the Y-axis to a specified range by showing a pop-up window in which
the minimum and/or maximum values of the Y-axis can be set. When the axis is locked,
a 1 and/or | symbol is shown at the left top and/or bottom corner of the plot. Locked
plots do not auto-scale.

e Auto-Scale Y-axis: Toggle automatically scaling the Y-axis. This overrules the global auto-
scaling option in paragraph 4.13.2.2.
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e Save as SVG...: Save the plot as a SVG image.

4.1.3 Information Area

The information area at the bottom of the main screen shows the list of event messages and the
legend with connected nodes. In addition, a zoom-slider, a pan-slider and buttons to set and
get the time of the nodes can be added to the information area via the menu (View, Toolbox).

4.1.3.1 Notification Area

Event notifications are displayed in the notification area. They give information about the out-
come of certain actions, such as plugged-in or removed devices, connecting to or disconnecting
from a device, starting or stopping logging, downloading or exporting files, modifying sensor
configurations, etc. By clicking the header of the time column, the notifications can be sorted
in ascending or descending time order. Right clicking an item in the list provides the following
options: copy the selected line(s), copy all lines, and clear the notification area.

The icon in front of a message indicates the notification type. A green check-mark means
success, a red cross means error, an orange triangle means warning and a blue circle means
information.

4.1.3.2 Legend

The legend contains a list of all the nodes of which sample data is received. The first column
shows the line colour and ID for each node. The NodelD can be extended with a name in para-
graph 4.13.2.3. The second column (Signal) displays the radio signal strength (when connected
via a gateway), or the transmission type (when connected via USB). The third column (Battery)
shows the battery level for each node, and whether the node is charging. The fourth column
(Loss) shows the percentage of lost samples over the last period (see also paragraph 4.13.2.1).
The fifth column (Flash) shows whether the node is logging to flash or not. The sixth column
(GNSS) shows whether a node equipped with a GPS or GNSS sensor has a fix or not. The legend
can be sorted on every column. Columns can be hidden by right-clicking the column header.
Double-clicking on the legend opens the Detailed Status window (see paragraph 4.1.3.4).

The radio strength is updated every second. The battery level is, by default, updated every
ten seconds. The loss update interval can be configured via the global preferences (see para-
graph 4.13.2.1).

4.1.3.3 Zoom and Pan

The zoom and pan sliders can be used to change the visible data in the plots. The zoom slider
behaves the same as the zoom buttons in the toolbar (Section 4.1.1) and allows to zoom the
X-axis in or out. The pan slider allows the move back in time and show older data. The maxi-
mum number of seconds to pan can be configured in the global settings (Plot History in para-
graph 4.13.2.1). If panning is active, plots are not updated with new sample data.
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The Detailed Status Overview window (see Figure 18) can be accessed by double clicking an
item in the legend or via the View menu, sub-menu Detailed Status. The window shows de-
tailed information about the battery level, CPU temperature, external input, RSSI and sample
loss of the connected nodes. The plots are cleared when (re)connecting to a device or when
using the Clear button.

Figure 18: Detailed Status information

The battery, temperature and external input plots are updated when status information from
a node is received via automatic status messages (usually every ten seconds). The RSSI plot
is updated every second with the average value of the received RSSI information. The sample
loss plot is updated every second with the detected sample loss. The time on the X-axis is the
system time.

A checkbox is available to disable automatic updating of the plots. This can be used to prevent
the plots from resetting when zoomed in. The Send Request button broadcasts a message to
all nodes with a request to send the current battery and CPU temperature value. The Plots
button can be used to show or hide specific plots.
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4.2 Connecting to a Device

In this section we describe how an Inertia device can be connected to the PC, using the follow-
ing connections:

e USB: Any Inertia device can be connected to the PC using USB. The USB-C connector
of the ProMove-V and the mini-USB connector of the gateway can be used for direct
connection to the PC using a USB cable.

e Ethernet: The Advanced Inertia Gateway can also be connected using Ethernet to the
PC. The gateway can be connected either directly to the network adapter of the PC using
an Ethernet cable, or indirectly using an Ethernet cable to a (wireless) switch or router
that is in the same local network as the PC. Inertia Studio requires Npcap or WinPcap on
Windows and libpcap on Linux and macOS to access the network adapter and receive
the Raw Ethernet data.

The connection can be started via the Connect button in the toolbar or from the File menu
item, option Connect.

4.2.1 Connecting to a Device Using the Toolbar

Pressing the arrow next to the Connect button in the toolbar opens the drop-down menu
shown in Figure 19:

¢ The option Connect... opens the Connection Configuration window, which is explained
in Section 4.2.2.

e The option Available... opens a pop-up window with all the available devices, including
the active network adapters. A setting in the Global Preferences (Section 4.8.1) can hide
the network adapters from the list of available devices.

¢ Below the line, a list is shown with the names of the available Inertia devices connected
through USB and the active network adapters, i.e. the local and/or the wireless network
adapters. Next to them, the corresponding port numbers are given. A e symbol in front
of the name indicates the device is selected. A » symbol in front of the name indicates
the device is connected.

Select the desired device and press the Connect button in the toolbar to connect.

4.2.2 Connecting to a Device Using the Menu

The option Connect from the File menu item opens the Connection Configuration window from
Figure 20. The window shows a list with Stored Configurations, i.e. all the connections to Iner-
tia devices that were previously used and those that are currently available. The list includes
the devices connected through USB and the active network connections, e.g. the local and/or
the wireless network connections. The port name (“com*“ on Windows and “/dev/*“ on Linux)
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Connect...
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Inertia Gateway Advanced 103 [com4]
+ - ProMove V Node 8 [comB]

Figure 19: Connect drop-down menu

is shown next to the device name. A green dot indicates the device is available. The » symbol
indicates the device is connected.

By pressing the Available? button, the list is updated and a pop-up window with all the avail-
able devices is shown. The Show button loads the selected connection into the main screen.
The Add... button can be used to manually add a device to the list if it is not automatically de-
tected. The Remove button removes a selected device from the list. The Connect/Disconnect
button starts and shows, or stops, the selected connection with the device.

Connection Configuration x ]
Stored Configurations
Available Connected Port Name
] » com4 Inertia Gateway Advanced 103 |
J comb ProMove V Node 8

com10  ProMove V Node 2
com1l  ProMove-mini Node 619
com111 ProMove-mini Node 701
com112 ProMove-mini Node 700
com113 ProMove-mini Node 699
com115 ProMove V Node 3

Available? Show Add...

s
T
=]
o

< Advanced

Disconnect Close J

Figure 20: Connection Configuration
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4.3 Logging to File

When connected to an Inertia device, the incoming data can be stored/recorded in a log file.
The default file format is itlog (Inertia Log File). Incoming samples, node information and con-
figurations, etc, are stored in the file. An itlog file can be exported to a different format (see
Section 4.6). The itlog format also supports filling in lost samples after an experiment is fin-
ished, see Section 4.5.

There are two options that can be used to enable logging to file:

1. By using the Record button from the toolbar; to change the settings for creating a log
file, select the Log to File... option from the drop-down menu of the Record button; this
option opens the Logging Configuration window for logging to file (see Figure 21).

2. By selecting the Log to File... option from the File menu, Record item; this option opens
the same Logging Configuration window for logging to file (see Figure 21).

Logging Configuration X

Logto File Logte Flash

Log to File Settings

Filename
Chexperimentsilogfileitlog Browse
Description
Compression None ~
Unique Filename Date in Filename +
Stop Logging After  [] | 0 2 | o | o2

Start Flash Logging

Mew File Every

Actions After Stopping [itlog)

Fill-in Lost Samples
Export s

Record

Close

Figure 21: Log to File Configuration
In the Logging Configuration window, the settings for creating a log file can be modified as
follows:
¢ Filename: The name of the log file. The default file format is itlog.

e Description: A description that can be added to the beginning of the (exported) log file.
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e Compression: An optional compression format used for the log file, resulting in a smaller
file size. Supported compression methods are: gzip (.gz, GNU Zipped Archive), bzip (.bz2,
BZIP2 Compressed Archive) and zlib (.Z, UNIX Compressed Archive).

¢ Unique Filename: Selects the way of handling existing log files with the same name:
— Overwrite: The existing file is overwritten.

— Auto-Number: Files are numbered in sequence with the following naming convention:
<filename>[_Ne].ext, where ext is the file extension and Ne is the sequence number;
this number is automatically increased every time a log file with the same name is
created.

— Date in Filename: The current local or UTC date and time are added to the filename;
the timestamp is formatted as described in 1ISO 8601
(i.e. [YYYYMMDDThhmmss_]<filename>.ext).

e Stop Logging After: This option can be enabled to automatically stop logging to file. The
duration can be entered as hh:mm:ss. When active, a countdown is shown in the toolbar.

o Start Flash Logging: Starts (and stops) logging to flash when a log file is created. This option
is enabled by default when Fill-in Lost Samples is enabled.

* New File Every: Start logging to a new file once the provided number of seconds or file size
is reached. Fill-in Lost Samples and Export should be disabled.

e Fill-in Lost Samples: Fills-in lost samples when logging to file is finished (see Section 4.5).

e Export: Exports the log file when logging to file (including filling in lost samples) is finished.
The button opens the Section 4.6 window.

If a device is connected, the Record button can be used to save the settings and start creating a
log file. If the device is disconnected, the Save button can be used to save the current settings.
The Stop button can be used to stop logging. These buttons behave similarly to the Record /
Stop button in the toolbar, described in Section 4.1.1.
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4.4 Logging to Flash

ProMove-V nodes have an internal flash memory that can be used to store sensor data. Flash
logs are used to fill in lost samples after an experiment, as described in Section 4.5. Flash logs
can also be created manually, as described in Section 4.4.1. Section 4.4.2 describes the way
the flash logs can be downloaded to the PC.

4.4.1 Starting and Stopping a Flash Log

The Log to Flash option from the File menu, Record item, opens the Logging Configuration
window for logging to flash (see Figure 22).

The Logging Configuration window shows the list of all devices in the network. For each node
in the list, the » symbol indicates whether the node is logging to flash or not. If a timer is used
when starting the flash log (the Stop Logging After option is enabled), a countdown is visible
in the list. The last column in the list shows the sensor data types that are logged to flash (see
Section 4.8 to enable or disable sensors).

Logging Configuration

Lag to File | Log to Flash

Log to Flash Settings
[m] » NodelD Tirmer Legging Data From:

1 Accelerometer, Compass, Gyroscope,
» 2 Accelerometer, Compass, Gyroscope,
3 00:02:19  Accelerometer, Compass, Gyroscope,
4 Accelerometer, Compass, Gyroscope,
| 00:04:14  Accelerometer, Compass, Gyroscope,
i} Accelerometer, Compass, Gyroscope,
£ >
Stop Logging After [ ] III = = III =

Start Stop
Close

Figure 22: Log to Flash Configuration
The Start / Stop buttons can be used to send a command to the checked node(s) to start or stop

logging to flash. The Stop Logging After option activates a timer for stopping the flash logging.
Closing Inertia Studio while a timer is active does not determine a node to stop logging to flash.
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The format of the timer is hh:mm:ss. During logging to flash, the blue led blinks in short bursts.
Starting or stopping a flash log can also be done by pressing shortly twice on the button of the
node (see Section 3.2).

When starting or stopping a flash log, a notification message appears in the information area at
the bottom of the main screen with the response from the node, indicating success or failure.
A failure can occur when logging to flash is already started (or stopped).

Flash logs are named LOG<Ne>.LOG, where No is the first available number starting from 1.
The creation date of the flash log is also recorded. The date is based on the internal clock
of the node. If the battery of a node is fully drained, the clock is reset, which can result in
an incorrect creation date. The internal clock is automatically synchronized with the PC time
when data from a node is received by Inertia Studio.

A ProMove-V sampling at 200 Hz with all sensors enabled uses about 24 MB of flash per hour.

4.4.2 Downloading a Flash Log

Downloading a flash log can be done either wirelessly or through a USB cable, which is much
faster. By selecting the Download option from the File menu, the Download Flash Logs window
appears, as shown in Figure 23. When a node is selected in the drop-down list, status informa-
tion about the internal flash is shown, and the File list is updated with the flash logs present
on the internal flash of the node. The filename, file-size and creation date (local time) of each
file is shown in the list. By selecting a node or using the Refresh button on the right hand side,
the status information and file-list are updated. Active files (e.g. files currently being created)
are not included in the file list.

To download a file, select it in the File list and adjust the following options:

e Destination: The name of the file (itlog format). Several wildcards are supported in the
filename:

— {name} or %s: Insert the full flash file name (without extension).

— {no} or %d: Insert the number of the flash file (e.g. 34 for LOG34.LOG).

— {date} or %c: Insert the creation date of the flash file (in ISO 8601 format).
— {id} or %i: Insert the node ID.

¢ Unique Filename: Selects the way of handling existing log files with the same name (same
as in Section 4.3).

¢ Use Date from Flash File: Set the creation date of the file to the date of the flash file.

e Export: Export the file when downloading is finished. Use the button to open the Export
Settings. (see Section 4.6).
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Press Download to start the download. If the node is transmitting data, transmission will be
temporarily disabled until the download is finished.

During downloading, the progress is shown in the list. Information about the progress is also
shown in the information area at the bottom of the main screen (see paragraph 4.1.3.1). When
downloadingis in progress, the Cancel button can be used to cancel the process. If afileis being
downloaded, other files of the node can be queued so they will start downloading as soon as
the current file is finished. Select one or more LOG*.LOG files, adjust the file options, an press
Queue.

. Download Logfiles x|
Node Overview
Node: 8 v O} Format.
Status: OK
6MB / 29496 MB (5 files)

Name Size Created Progress Status
COMFIG.CFG 340B 2024-11-15 15:37:.08
SYSTEM~1. OB 2024-01-22 10:39:18

LOG1.LOG 4579 KB 2024-03-12 14:09:24
LOG210G  91,7KB  2024-07-11 16:08:22
LOG3.1OG 55MB  2024-11-21 16:09:48

Destination
CAlnertia\(id}-{namet.itlog | Browse |
Unigue Filename Date (local) in Filename ~

Use Date from Flash File [

Export a8 x
Download Cance

Close

Figure 23: Download Flash Logs

4.4.3 Deleting Flash Logs

Flash logs can be removed from the flash memory using the Format button in the Download
Logfiles window (Figure 23). This action removes all files from the internal flash memory. For-
matting takes about 5 to 10 seconds. A message is shown when formatting is finished.

Do not turn the nodes off during formatting!
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4.5 Filling in Lost Samples

When performing an experiment with wireless sensor nodes, there is almost always some data
loss. This loss can be filled in automatically after the experiment is finished. This feature is
available only for experiments performed with a gateway, when the sensor nodes are in Syn-
chronous mode (see Section 4.8.1 for details about sampling mode). If the sensor nodes are in
Stand alone mode, or if the sensor nodes are connected using a USB cable this feature is not
available.

The sections below explain this process of filling in the lost samples.

4.5.1 Automatic

Enable Fill-in Lost Samples when creating a logfile (see Section 4.3). Once logging is stopped,
a pop-up is shown informing that missing data will be filled in. Once continued, the Fill-in Lost
Samples window is shown (Figure 24) and missing data is automatically filled in.

The process consists of three stages:

1. First, the existing logfile is analyzed and missing data of each node is identified. During
this stage, a progress bar for each node is filled with blue bars. The tint of the color rep-
resents the amount of lost data: white is 100% loss, dark blue is 0% loss. The percentage
inside the progress bar is the total percentage of samples available.

2. During the second stage, the missing data is requested wirelessly from the nodes (Fig-
ure 24). The progress bars are actively being updated to reflect the received data. The
lighter segments change to dark-blue.

3. Inthe third stage, the received data is merged into the itlog file (Figure 25). The progress
bars are filled with green bars to show the progress. If there is still some missing data,
sections in a progress bar are made red and messages with information about the miss-
ing sections are added to the notification area. A manual restart could fill in the remain-
ing missing samples (see Section 4.5.2).

Fill-in Lost Samples X Fill-in Lost Samples

: Manual Settings Manual Settings

Progress Progress

+ I
File: logfileitlog File: logfileitlog

Status: Requesting samples... Status: Merging...

| Details | Details

Cancel Close Cancel Close

Figure 24: Requesting Figure 25: Merging

Once the process is finished, and if Export was enabled when the logfile was created, the file
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is exported in the background. If the fill-loss process is canceled using the Cancel button, a
pop-up asking to continue with export is shown.

4.5.2 Manual

Filling in lost samples can also be started manually. Open the window via the menu (File, Fill-in
Lost Samples) and expand the manual settings using the Manual Settings arrow (Figure 26).
Provide the following parameters:

* File(s): One or more itlog files to be filled in.
e Port: The port used to access the node(s), usually the port of the gateway.

e Export: Export the itlog file when filling in lost samples is finished or canceled. Use the
button to open the Export Settings. (see Section 4.6).

e Backup: Keep a backup of the unfilled file (named <filename>_BACKUP_.itlog).

e Slots: Temporarily change the number of slots (to a lower value) to increase the fill-loss
speed. This should be equal or higher than the number of devices in the network. Leave
empty or use O for the default number of slots.

¢ Flash Diff (S): The maximum time difference in seconds between the creation date of the pc
file and the node’s flash file.

Press Start to start the process.

Fill-in Lost Samples X

Manual Settings

Fill S5ample-Loss Settings

File(s) ‘ logfile.itlog ‘ Browse

Port comd - Inertia Gateway 8~
Export O &

Backup

Flash Diff (<)

Start

Progress

File:
Status:

Details

Cancel Close

Figure 26: Manual settings

The Details arrow expands the window and shows a list with all status messages. The messages
can be copied or cleared using the Copy and Clear buttons. The Auto-scroll checkbox enables
or disables automatic scrolling to the latest message.
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4.6 Exporting a Logfile

Inertia Log Files of type itlog can be exported to different file types using the Export Logfiles
window (see Figure 27), which can be accessed from the menu (File, Export). The following

parameters can be modified:

e Format: The file format to export the itlog file to (Figure 28). Settings specific to the file
format can be modified via the Configure button (see the next sections for available options).

e Compression: An optional compression format used for the exported file, resulting in a
smaller file size. Supported compression methods are: gzip (.gz, GNU Zipped Archive), bzip
(.bz2, BZIP2 Compressed Archive) and zlib (.Z, UNIX Compressed Archive).

¢ Unique Filename: Selects the way of handling existing log files with the same name (same

as in Section 4.3).

e Source(s): The itlog file(s) to export or merge. The Destination filename is automatically
updated to match the source name and the selected file format.

Use the Start button to save the settings and export the file(s). Active and previously exported
files are shown in the Activity List. Double-clicking an item opens the exported file in its default
program. An active item can be canceled using the Cancel button. Previously exported files
in the activity list can be cleared using the Clear button. The folder of a selected item can be

opened using the Open Folder button.

. Export Logfiles X

Settings

Format sV i~ Configure

Compression MNane =

Unique Filename  Auto-Number e

Source(s)

sting2024-03-22 Orientation PM-W\test_IMU_l.itlog ~ Browse

Destination
“esting\2024-03-22 Orientation PM-V\test_IMU_1.csv Start

Activity List

Source Destination Progress Status

test_ IMU_l.itlog test_IMU-[nodelD][_Mol.csv 100% Finish..
Cance Clear Open Folder

Close

Figure 27: Export logfiles

Export Logfiles X

Settings

Format

Configure

Supported export formats:
C5V: Comma-Separated Values File

atlab File

V3D: Visual3D ascii File

ITLOG: Inertia Technology Logfile (merge files together)

Compression

Unigue Filename

Source(s)

sting\2024-03-22 Orientation PM-V\test IMU_1.itlog  Browse

Destination
‘esting\2024-03-22 Orientation PM-Vitest_IMU_1.csv Start

Activity List

Source Destination Progress Status

test_IMU_l.itlog test_IMU-[nodelD][_Nol.csv  100% Finish..

Open rolae

ance Clear

Close

Figure 28: File format options
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4.6.1 (CSV Settings

Inertia Log Files can be exported to a Comma Separated Values file (CSV). The CSV Settings can
be modified in the CSV Settings window (see Figure 29), accessible via the menu (Configuration,
File Types, CSV Settings) or from the Export window.

A CSV file starts with a header identifying each column. Each subsequent line in the CSV file
consists of a timestamp and the sensor data sampled at that timestamp.

The following settings can be modified for the CSV file format:

* One File per Node: A separate file is created for each node; the node number is appended
to the filename: <filename>[_nodeNe].ext. When disabled, one file with data from all nodes
is created.

e Repeat Previous Value: When sensors have a lower sampling rate than the global sampling
rate, empty values are added to the CSV file (no value between commas). . By using this
option, instead of logging an empty value, the last received value is repeated until a new
value is received.

¢ Add Info to Beginning of File: Add information such as node information, sensor settings,
units of measurement, a description, etc, to the beginning of the log file. The information
lines start with a #.

The sensor data added to the CSV file can be configured by (un)checking the desired Columns.
The Apply button saves the settings and closes the window. The Close button discards any
modified settings and closes the window.

CSV Settings *

Settings
8 One Fil

) Repeat Previous Value

@ Add Info to Beginning of File

Apply

Columns
Timestamp
SeqNr, Slot, Index
Node ID
Lost Samples
8 Accelerometer
Compass
Gyroscope
RSSI
CRTC
Orientation (Quaternion)
Orientation (Euler Angles)
[JADC
Status
8 Accelerometer (High G)
Pressure
@ Temperature
O IMA
Oo
Extra Files
GNSS

Close

Figure 29: CSV Settings
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4.6.2 MAT Settings

Inertia Log Files can be exported to a MatLab MAT file. The MAT Settings can be modified in
the MAT Settings window (see Figure 30), accessible via the menu (Configuration, File Types,
MAT Settings) or from the Export window.

The MAT file contains a global structure array with a field for each node structure. Each node
structure contains four fields. Field columns contains the column names and indices of the
columns, fields combines multiple columns into one field (e.g. ax, ay and ax into accelero-
meter), data contains the sensor data, and samplingRate contains the sampling rate.

The following settings can be modified for the MAT file format:
e Struct Name: The name of the global structure array.
e MAT Version: The MAT-file version (see MatLab documentation).

* No. of Samples: The number of samples in the MAT file. This option is not relevant when
exporting an jtlog file to MAT. Only when logging directly to a MAT file, the number of sam-
ples to store needs to be known beforehand. If more (or less) samples are logged, these are
ignored (or filled with NaN).

The sensor data added to the MAT file can be configured by (un)checking the desired Columns.
The Apply button saves the settings and closes the window. The Close button discards any
modified settings and closes the window.

MAT Settings *

Settings Columns
Struct Name inertia _ Ve
|_J SampleMumber

O SeqMr, Slot, Index

Mode D

Lost Samples

B Accelerometer
Compass

Gyroscope

[CJRSSI

[CJRTC

Orientation (Quaternion)
Orientation (Euler Angles)
Capc

Status

B Accelerometer (High G)
Pressure

B Temperature

CJima

o

Extra Structs

[ GNSS

MAT Version

MNo. of Samples
(Ignored by Export)

Apply Close

Figure 30: MAT Settings
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4.6.3 Visual3D Settings

Inertia Log Files can be exported to a Visual3D ASClI file. The Visual3D Settings can be modified
in the Visual3D Settings window (see Figure 31), accessible via the menu (Configuration, File
Types, Visual3D Settings) or from the Export window.

The Visual3D ASCII file starts with a header identifying each column. Each subsequent line in
the file represents a frame at a specific time point with data from all sensor nodes.

The following settings can be modified for the Visual3D file format:

* Repeat Previous Value: When a sensor value is missing, use the previous value when avail-
able or use the Empty Value.

e Empty Value: Use this value when there is no known sensor value.
e Owner: The source of the data.

¢ Point Rate: Add a point rate time signal and set the start time.

¢ Analog Rate: Add an analog rate time signal and set the start time.

When data of individual sensor nodes is in separate files, for example when downloaded from
flash, it can be merged together before exporting to a Visual3D ascii file. Enable Merge Before
Converting and provide an optional name to use for the merged file. Select all the files to
merge in the Export window.

The sensor data added to the Visual3D file can be configured by (un)checking the desired
Columns. The Apply button saves the settings and closes the window. The Close button dis-
cards any modified settings and closes the window.

V3D Settings x
Settings Columns
ORepe Timestamp
SeqNr, Slot, Index
Bulpuriclis e — Node ID
Owner GLOBAL Lost Samples
— Accelerometer
Point Rate 0
Compass
[JAnalog Rate 0 Gyroscope
Merge Flash Files R
] RTC
Merge Before Converting Orientation {Quaternion)
MName Based on First Source File Orientation (Euler Angles)
Name merged.itlog @ ADC

Status

Accelerometer (High G)
Pressure

Temperature

IMA

1/0

Apply Close

Figure 31: Visual3D Settings
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4.6.4 ITLOG Settings

Inertia Log Files can be merged or rewritten. The ITLOG Settings can be modified in the ITLOG
Settings window (see Figure 32), accessible via the menu (Configuration, File Types, ITLOG
Settings) or from the Export window.

When multiple itlog files are selected in the export window, these will be merged together into
one file. When one jtlog file is selected, it will be parsed and rewritten.

By default, the source info of the new itlog file will be the same as the (first) source file. The
source info can be changed by enabling the Enable Replacing Source Info checkbox. Use the
Load Info From Source File button to fill the fields with the source info of the (first) source file.

The following fields can be modified:

Created Date: Unix timestamp when the file was created (required).

Version Info: Information about the application that created the file.

Original Filename: The original name of the file, for example when the file was downloaded
from the flash memory of a sensor node.

e Description: Extra information that was provided when creating the file (see Section 4.3).

The Apply button saves the settings and closes the window. The Close button discards any
modified settings and closes the window.

ITLOG Settings b4

Merge or re-write ITLOG file
Global

8 Enable Replacing Source Info

Load Info From Source File

Source Info

Created Date 0
Version Info

Criginal Filename

Description

Apply Close

Figure 32: ITLOG Settings
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4.7 Replaying a Logfile

The Replay Logfile window can be used to replay a previously created logfile in real-time, or
analyze and plot an entire logfile.

Replay Logfile x Replay Logfile
Logfile | logfile.tlog || Browse Legfile | logfile.itiog || Browse
(®) Real-time () Analysis (C)Real-time () Analysis
T Show in Log: Rollbacks Duplicate Timestamps Gaps
Show Sample Data in Plots (High Memery Usage!)
Sampling Rate (Hz) 200 ~
Number of Nodes
Read Interval '
600 samples/s
Reload Plot Clear Results
Start Stop Start Stop
Close Close
Figure 33: Replay Logfile window Figure 34: Analyze Logfile window

4.7.1 Real-Time
Real-time replay has the following options:
¢ Logfile: The logfile to be replayed.

¢ Hardware Type: (CSV only) The hardware type of the device used in the logfile. This is
necessary to determine to correct initial orientation in the tracker.

¢ Rewrite Replay: (CSV only) The logfile will be rewritten to a new file (same name, with
-replay appended), and the orientation (Euler angles and/or quaternions) will be re-
calculated.

e Sampling Rate: The sampling rate used in the logfile. Used to calculate the Read Interval.

¢ Number of Nodes: The number of nodes in the logfile. This is used to calculate the Read
Interval.

¢ Read Interval: The number of samples to read per second. The initial value is deter-
mined by the Sampling Rate and Number of Nodes, but the interval can be manually
adjusted. During a replay, the slider can be used the change the speed of the replay.

A replay is started with the Start button, and stopped with the Stop button. During the replay,
it can be paused with the Pause button. The buttons in the toolbar can also be used to control
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the replay. Replays are added to the drop-down menu of the Connect button. Finished replays
are removed from the drop-down menu when the Available... option is used.

4.7.2 Analysis

Replay analysis can be used to analyze a logfile and detect timestamp issues. It detects Roll-
backs (timestamp is lower than the previous timestamp), for example when the sampling rate
is changed during the experiment. Duplicate Timestamps are detected when subsequent time-
stamp are the same. Gaps are detected when samples are lost.

It has the following options:
* Logfile: The logfile to be analyzed.
¢ Rollbacks: Detect and show timestamp rollbacks in the log.
e Duplicate Timestamps: Detect and show duplicate timstamps in the log.
e Gaps: Detect and show timestamp gaps in the log.

¢ Show Sample Data in Plots: Collect all the sample data and show them in the plots once
analysis is finished. For large logfiles, this requires a lot of memory.

Analysis is started with the Start button, and stopped with the Stop button. During the analysis,
it can be paused with the Pause button. Once the analysis is finished the data of the logfile is
shown in the plots. When the plot layout is changed, Reload Plot can be used to recreate the
plots. Clear Results will clear the log and remove the collectd sample data from memory.
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4.8 Configuring the Sensors

The Sensor Settings window can be used to modify the configuration of Inertia nodes. This
window is accessible via the toolbar and via the Configuration menu, item Sensor Settings.
Once a device is connected, the configuration options of the detected Inertia nodes is shown
in this window.

Sensor Settings (comb5)

~ Global

v Sensors
Accelerometer

- Compass

- @Qyroscope

-~ Barometer

Accelerometer (High G)

- Temperature
- Status
Sampling Channels

[ NodelD”
94 (Gateway)

IR R R R
[ T O o B e S R N

3

Refresh H ()]

Apply Settings Close

Figure 35: Sensor Settings

Figure 35 shows the Sensor Settings window, which is divided in the following areas:

® The node list area, marked with green in Figure 35, contains the list of devices available
via the currently selected connection. When a node is selected, its configuration options
are shown in the sensor tree. When a node is checked by using the checkbox beside it,
the actions of the buttons refer to this node. In Figure 35, all nodes are checked, so the
configuration is applied to all these nodes after pressing the Apply Settings button.

e The sensor tree, marked with red in Figure 35, shows the available configuration op-
tions of the selected nodes in the node list. When choosing an option in the tree, the
corresponding configuration settings are shown in the settings panel. The different con-
figuration options in the sensor tree are discussed in the subsequent sections.

e The buttons, marked with blue in Figure 35, have the following functions:
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Refresh This button can be used to request all the configurations from all nodes.
The purpose is to make sure that configurations are successfully applied and cor-
rectly retrieved by Inertia Studio.

Store This button stores the current configuration of the checked nodes in their
flash memory, so the settings are retained when the nodes are turned off. The
button is not visible if configurations are automatically stored (paragraph 4.13.2.1).

Restore This button can be used to restore all the configurations of the checked
nodes. The nodes are reset to their factory-default settings.

Apply Settings This button applies all the modified settings (shown bold in the sen-
sor tree) to the checked nodes in the list. If no settings are modified, the currently
shown settings are applied If settings are stored automatically, a 15 second count-
down is shown.

Close This button closes the window, discarding all modified settings.

e The settings panel, marked with in Figure 35, shows the settings available for
the selected configuration option of the selected node in the node list. These settings
are discussed in detail in the subsequent sections. When invalid or not recommended
settings are used, these settings are marked with a red (invalid) or orange (not recom-
mended) colour. Invalid settings cannot be applied. Error, warning and information
messages are shown below the Apply Settings and Close buttons. The settings panel
also contains a Refresh and Restore button at the top-left corner. These buttons can be
used to refresh or restore the selected configuration of the selected node.

4.8.1 Global Settings

By selecting the Global configuration option from the sensor tree, the global settings can be
edited, as shown in Figure 36:

e Transmit Data: Data transmission can be switched off by unchecking the check-box. Nodes
keep sampling (i.e. to store data in the flash memory).

e Sampling Rate (Hz): Selects the sampling rate used by the sensors. Some sensors may be
limited to a lower sampling rate. When using Synchronous sampling mode, the default max-
imum number of nodes supported by the network for a selected sampling rate is shown on
the right. The maximum sampling rate is 1000 Hz.

* No. of Nodes: The number of nodes in the network to which the device is currently con-
figured. For gateways this can be modified to match the configuration of the node(s). For
nodes this is automatically changed to match the gateway settings. The combination of
Sampling Rate and No. of Nodes determine the number of samples in a radio packet. For
best performance, this should be a round number.
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e Sampling Mode: Inertia nodes can be configured to Synchronous or Stand-alone sampling.
When sampling synchronously, the gateway dictates the time when the nodes take a sample.
Nodes do not take samples until a gateway is detected. In stand-alone mode, each node
decides on its own when to take a sample.

e Transmit Type: Data can be transmitted using Wireless (Radio), USB or both.

e Frequency Channel: Selects the frequency channel used by the Radio. To establish a con-
nection, the channel of the nodes has to be the same as the channel of the gateway. When
changing channel, it is recommended to first change the frequency channel of the nodes,
and then the channel of the gateway.

* Disable Radio: Disable to radio, for example to save power. The device will not be accessible
anymore, except via USB.

Sensor Settings (com5)
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Temperature
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~Sampling Channels
Transmit Type Wireless v
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4
5
6
@3 Refresh H (]
Apply Settings Close

Figure 36: Global Settings
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4.8.2 Accelerometer Settings

By selecting the Accelerometer configuration option from the sensor tree, the accelerometer
settings can be edited, as shown in Figure 37:

e Enabled: Enables sampling of the accelerometer.

¢ Transmit Data: If the accelerometer is enabled, data will be transmitted. This is overruled
by global transmission settings (see Section 4.8.1).

e Log to Flash: If the accelerometer is enabled, data will be logged to flash. See Section 4.4.1
about how to start a flash log.

e Sampling Rate (Hz): The sampling rate of the accelerometer (maximum 1000).

* Range (g): Sets the maximum acceleration that can be measured. Select from the supported
options in the drop-down list. A lower range has a higher sensitivity.

e Calibration: Advanced option that adjusts the scaling and offset of each axis (see Section 4.9
for details about the calibration method).

Sensor Settings (comb5)
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ensors Configuration
Accelerometer
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Figure 37: Accelerometer Settings
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4.8.3 Compass Settings

By selecting the Compass configuration option from the sensor tree, the compass settings can
be edited, as shown in Figure 38:

Enabled: Enables sampling of the compass.

Transmit Data: If the compass is enabled, data will be transmitted. This is overruled by
global transmission settings (see Section 4.8.1).

Log to Flash: If the compass is enabled, data will be logged to flash. See Section 4.4.1 about
how to start a flash log.

Sampling Rate (Hz): The sampling rate of the compass (maximum 100 Hz).

Range (gauss): Selects the magnetic full scale. Supported options are: 4, £8, £12 and +16
gauss. A lower scale has a higher sensitivity.

Calibration: Advanced option that adjusts the scaling and offset of each axis (see Section 4.9
for details about the calibration method).

Sensor Settings (comb5)
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Figure 38: Compass Settings
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4.8.4 Gyroscope Settings

By selecting the Gyroscope configuration option from the sensor tree, the gyroscope settings
can be edited, as shown in Figure 39:

Enabled: Enables sampling of the gyroscope.

Transmit Data: If the gyroscope is enabled, data will be transmitted. This is overruled by
global transmission settings (see Section 4.8.1).

Log to Flash: If the gyroscope is enabled, data will be logged to flash. See Section 4.4.1
about how to start a flash log.

Sampling Rate (Hz): The sampling rate of the gyroscope (maximum 1000 Hz).

Range (°/s): Sets the maximum rotational velocity the gyroscope can measure. Select from
the supported options in the drop-down list. A lower range has a higher sensitivity.

Offset Correction: The gyroscope has a factory, temperature dependent, offset. Enable an
algorithm that zeros the gyroscope axes when no movement is detected.

Calibration: Advanced option that adjusts the scaling and offset of each axis.

Sensor Settings (comb5)
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Figure 39: Gyroscope Settings

inertia-technology.com Page 45 of 74


http://www.inertia-technology.com

4.8.5 Barometer Settings

By selecting the Barometer configuration option from the sensor tree, the barometer settings
can be edited, as shown in Figure 40:

Enabled: Enables sampling of the barometer.

Transmit Data: If the barometer is enabled, data will be transmitted. This is overruled by
global transmission settings (see Section 4.8.1).

Log to Flash: If the barometer is enabled, data will be logged to flash. See Section 4.4.1
about how to start a flash log.

Sampling Rate (Hz): The sampling rate of the barometer (maximum 100 Hz).
Range (hPa): Sets the pressure range the barometer can measure, which is 260-1260 hPa.

Calibration: Advanced option that adjusts the scaling and offset.

Sensor Settings (comb5)
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Figure 40: Barometer Settings
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4.8.6 High-G Accelerometer Settings

By selecting the Acclerometer (High G) configuration option from the sensor tree, the high-g
accelerometer settings can be edited, as shown in Figure 41:

e Enabled: Enables sampling of the high-g accelerometer.

e Transmit Data: If the high-g accelerometer is enabled, data will be transmitted. This is over-
ruled by global transmission settings (see Section 4.8.1).

* Log to Flash: If the high-g accelerometer is enabled, data will be logged to flash. See Sec-
tion 4.4.1 about how to start a flash log.

e Sampling Rate (Hz): The sampling rate of the high-g accelerometer (maximum 1000 Hz).

e Range (g): Sets the maximum acceleration the high-g accelerometer can measure. Select
from the supported options in the drop-down list. A lower range has a higher sensitivity.

e Calibration: Advanced option that adjusts the scaling and offset of each axis.
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Figure 41: High-G Accelerometer Settings
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4.8.7 Temperature Settings

By selecting the Temperature configuration option from the sensor tree, the temperature sen-
sor settings can be edited. The settings for the temperature sensor are not related to the CPU
temperature from paragraph 4.1.3.4. The settings are shown in Figure 42:

Enabled: Enables sampling of the temperature sensor.

Transmit Data: If the temperature sensor is enabled, data will be transmitted. this is over-
ruled by global transmission settings (see Section 4.8.1).

Log to Flash: If the temperature sensor is enabled, data will be logged to flash. See Sec-
tion 4.4.1 about how to start a flash log.

Sampling Rate (Hz): The sampling rate of the temperature sensor (maximum 1000 Hz).

Range (°C): Sets the temperature range the temperature sensor can measure, which is -40-
85 °C.

Calibration: Advanced option that adjusts the scaling and offset.

Sensor Settings (com5)
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Figure 42: Temperature Settings
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4.8.8 GNSS Settings

For ProMove-V sensor nodes that include the GNSS option, the related settings can be con-
figured by selecting the GNSS configuration option from the sensor tree. Figure 43 shows the
GNSS Settings, with the following parameters:

Enabled: Enables the GNSS sensor and sampling of GNSS data.

Transmit Data: If the GNSS sensor is enabled, data will be transmitted. This is overruled by
global transmission settings (see Section 4.8.1).

Log to Flash: If the GNSS sensor is enabled, data will be logged to flash. See Section 4.4.1
about starting a flash log.

Sampling Rate (Hz): The sampling rate of the GNSS sensor (maximum 10 Hz).
Static Navigation: Filters out position jumps when the sensor is stationary.
Constellation: The satellite constellations used by the sensor. This cannot be changed.

Other checkboxes: Include this data in the GNSS sample. The items are described in more
detail in Section 4.12.
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Figure 43: GNSS Settings
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4.8.9 Status Settings

By selecting the Status configuration option from the sensor tree, the settings for status sam-
ples can be modified. Status samples consist of the battery level, CPU-temperature and exter-
nal input detection (e.g. whether USB is plugged in). Figure 44 shows the Status Settings, with
the following parameters:

e Enabled: Enables the status samples.

e Interval (s): The interval in seconds at which status samples are transmitted.
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Figure 44: Status Settings
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4.8.10 Sampling Channels

ProMove-V uses sampling channels for each enabled sensor. The Sampling Channels informa-
tion window (Figure 45) shows a summary of the used sampling channels, as follows:

e Channel: The channel number assigned to the sensor.

e Sensor: The name of the sensor that uses the channel.

e Wordsize (bit): The size in bits of one value.

* Ne Values: The number of values in a sample.

e Conversion: The factor to convert a raw measurement to unit.

The Status information is considered to be a separate sampling channel.
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Figure 45: Sampling Channels
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This section describes how to calibrate the accelerometer, the compass and the gyroscope
sensors of the ProMove-V nodes.

We will first explain how to calibrate the accelerometer and the compass. For the accelero-
meter, all nodes can be stacked and calibrated at once. For the compass, it is recommended
to calibrate only one node at a time, to minimize the electro-magnetic influence from other
nodes. Create a logfile of at least 30 s as described in Section 4.3. While logging, rotate the
node(s) a few times slowly around all three axes, at distance from any metal objects. Make
sure that on all three axes the minimum and maximum values are reached (for example reach
-9.8 and 9.8 m/s? on each accelerometer axes).

For the gyroscope, leave the nodes still on a surface and create a logfile of at least 30 s. In the
calibration process, the zero-offset of the gyroscope on all three axes will be determined.

After the calibration logfile was created (with rotations for the accelerometer and compass, or
laying still for the gyroscope), open the Calibration Configuration shown in Figure 46 via the
menu (Configuration, Sensor Calibration). Browse to the calibration logfile and click Calibrate.
By this, calibration results are calculated and the detected nodes are added to the Node box.

Calibration Configuration % Calibration Plot - Node 13 = O *

Calibration Settings
Source Filename  CAOneDrive\Inertia\ Testing!2025-05-14 Calibration Browse

+ Advanced
Calibrate

Calibration Results
MNode: 13 w
Accelerometer Compass Gyroscope
X Y z
Scale 1.02383 0.95593 1.00273
Offset -0.57480 -1.27377 0.15139

Use Results

Close

Figure 46: Calibration Configuration window Figure 47: Calibration Plot

Select a node and sensor type (accelerometer, compass or gyroscope) to see the calculated
Scale and Offset for each axis. Use Show Plot to open a plot that shows the effect of the new
scale and offset on the normalized sensor signal (see Figure 47 for the plot of a calibrated
compass). The scale and offset can be applied to the node by pressing Use Results. The calcu-
lated values are loaded into the Calibration settings of the node and sensor type in the Sensor
Configuration window (Section 4.8). Press Apply Settings in this dialog to apply the settings.

Note: Calibrating and applying results has to be done for each node and sensor type sepa-
rately. In general, the calculated scale should be around 1 and the offset around 0. If not, the
calibration source file is likely invalid (e.g. no rotation around the y-axis for the compass).
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4.10 1/0 Functionality

The Advanced Inertia Gateway has two BNC I/O ports, each supporting Trigger Output, Trigger
Input, Sync Output and Sync Input actions. The I/O ports can be configured for each of these
actions in the Configuration -> |/0O Settings menu, as described in more detail below.

4.10.1 Trigger Output

One or both EXT SYNC ports can be configured as Trigger Output in the Configuration -> I/0
Settings menu. Make sure the correct node and port number are selected, then select Trigger
and Output (see Figure 48).

1/0 Configuration x

Node |8 (Gateway) e @3 L—_‘ ﬂ
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1/C Configuration

Node |8 (Gateway) e @3 L—_‘ ﬂ
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|:| 500 Impedance Driving Enable Trigger Options:

Enable Trigger Options: Trigger Input Type | Edge ~
Trigger Output Type Level w Action to Perfform ] Reset Frame Counter

Send Timestamp Message

ok o T

Actions on which to trigger Start of Flash Logging
[Istop of Flash Legging

Level Reset Action Stop Flash Logging

[ Reset GPIO
Output Commands: []Show in Teolbar Input Commands: Show in Toolbar
Set High Set Low Toggle (High) Read
Apply Close Apply Close

Figure 48: Trigger Output settings Figure 49: Trigger Input settings
Trigger (Active) means that it is already the current selection. Several voltage ranges are pos-
sible up to a maximum range of =10 V to +10 V. Further options exist for inverting polarity and
50 2 impedance driving. The impedance can be set to very high (> 1 G(2) by deselecting the
50 €2 impedance.

For the trigger signal itself there are some options as well. Enable the trigger options by check-
ing Enable Trigger Options. The trigger type can be either Pulse or Level. It can be activated in
several ways: combined with starting or stopping flash logging, or set manually using the 1/0
buttons in the toolbar (see Figure 50).

The buttons in the toolbar can be enabled via the menu (View -> Toolbar -> Show I/0 Buttons)

inertia-technology.com Page 53 of 74


http://www.inertia-technology.com

or directly in the I/0 Configuration window by checking the checkbox Show in Toolbar.

Disconnect Record Pause Sensor Settings  Preferences Hide Clear Layout Tracker Zoom|In  Zoom Out Qutput High Qutput Low

Figure 50: Inertia Studio toolbar with 1/O Buttons

If the signal is successfully set, a message indicating success appears in the notification area.
If the signal is set during logging to file, the event is stored in the log file.

The trigger events are not stored in the flash memory of the nodes. Instead, when starting a
flash log, the output signal can automatically be set to high. When stopping a flash log, the
output signal can be set to low. To achieve this, check the checkbox of the gateway in the
Logging to flash window (see Section 4.4.1) before pressing Start and Stop.

4.10.2 Trigger Input

One or both EXT SYNC ports can be configured as Trigger Input in the Configuration -> /0 Set-
tings menu. Make sure the correct node and port number are selected, then select Trigger and
Input (see Figure 49). Trigger (Active) means that it is already the current selection. Options
are available for inverting polarity and 50 €2 input impedance. The input impedance can be set
to very high (> 1 G(?) by deselecting the 50 €2 impedance. Enable the trigger options by check-
ing Enable Trigger Options. For the trigger input type currently just one option is supported,
namely Edge.

If Enable Trigger Options is active, several actions can be performed when a trigger is received:
Reset Frame Counter resets the frame counter as well as the time stamps to O;

Send Timestamp Message sends a time-stamped message to Inertia Studio, which will then
appear in the notification area and, if data is being logged by Inertia Studio, in the log
file as well.

If the Hold-off time is set to O, the action is performed immediately after the trigger is received.
Otherwise, the action is performed after the delay time that is specified here.

4.10.3 Sync Output

One or both EXT SYNC ports can be configured as Sync Output in the Configuration -> |/O
Settings menu. In this mode, a periodic clock signal can be sent to connected devices for syn-
chronization. Make sure the correct node and port number are selected, then select Sync and
Output (see Figure 51).

Sync (Active) means that it is already the current selection. Several voltage ranges are possible
up to a maximum range of =10 V to +10 V. Further options exist for inverting polarity and 50 €}
impedance driving.
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Finally, the Synch frequency and its Phase shift can be set to a value between 1 and 1500 Hz
for the frequency and at most 1 second for the phase shift.

I/0 Configuration

Node |8 (Gateway) w

Port1 Port2
Sync (Active)

O lnput @) Output

I/0 Configuration

Node |8 (Gateway) w

Port1 | Port2
Sync (Active)

® Input (O Qutput

Range (V) |0.0-3.3 v [lnvert Pelarity

[Jlnvert Polarity [1500 Impedance

500 Impedance Driving Sync Frequency (H2)
Sync Frequency (Hz) Phaze Shift (z)

Phase Shift (<) 0.0025 w

Apply Close Apply Close

Figure 51: Sync Output settings Figure 52: Sync Input settings

4.10.4 Sync Input

Any one EXT SYNC port (but not both together) can be configured as Sync Input in the Con-
figuration -> /0 Settings menu. In this mode, a periodic clock signal can be received from an
external device for synchronization. Make sure the correct node and port number are selected,
then select Sync and Input (see Figure 52). Sync (Active) means that it is already the current
selection. Options are available for inverting polarity and 50 €2 input impedance, similar to the
other synchronization configurations.

Finally, the Synchronization frequency and its Phase shift can be set to a value between 1 and
1500 Hz for the frequency and at most 1 second (or less, depending on the frequency) for the
phase shift. The given frequency and phase shift are used by the synchronization algorithm in
the Gateway to determine what the incoming reference clock signal represents. The timing of
the whole system will then be based on this reference.
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4.11 The Tracker

The Tracker window (see Figure 53) can be accessed from the toolbar or via the menu View,
item Tracker. It shows the graphical real-time representation of the orientation of one or more
sensor nodes, calculated by the orientation algorithm.

A specific node to track can be selected from the Node drop-down list. Tracking multiple nodes
at the same time can be done by selecting the All option from the drop-down list. The View
drop-down list allows changing the 3D appearance of the tracked sensor nodes, as follows:

e Normal: The nodes are shown as coloured boxes.

¢ Model: The nodes are shown as 3D models of ProMove-V. The colour of the model
matches the colour of the node in the legend. A custom model can also be used, see
paragraph 4.13.2.5 for more information.

e Arm: The nodes are shown as coloured boxes, bound together as arm segments.

The slider can be used to zoom in or out. The Reset button resets the orientation algorithm of
the nodes (Section 5). The Order button shows a dialog where the order of the nodes can be
changed, and where nodes can be hidden. Several aspects of the tracker are configurable in
the Preferences window, see paragraph 4.13.2.5.

Tracker

Node | Al «| View Model | { Reset Order Close

o

&y
e

Figure 53: Tracker with six ProMove-V nodes
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4.12 GNSS Map

The GNSS Map can be accessed from the menu View, item GNSS Map. It shows the map, the
current position and track of the ProMove-V with GNSS sensor, once there is a GNSS position
fix. An active internet connection is required in order to display the map.

The GNSS sensor can be configured via the GNSS Settings (see Section 4.8.8). In addition to
the GNSS column in the legend (see paragraph 4.1.3.2), nodes with no GNSS fix are listed in
the bottom-right corner of the map.

The Settings checkbox toggles showing the settings in the window. The Map and Plot radio-
buttons can be used to switch between the map-view and the plot-view. The GNSS Track check-
box enables showing the GNSS track on the map. The GNSS Markers checkbox enables showing
a marker for each measurement on the track. The GNSS Auto-fit checkbox enables automatic
fitting of the GNSS track to the window. Invalid GNSS data can be shown once the GNSS has a
valid timetamp fix. Options are No Fix for GNSS data with no valid location fix, Navigation Valid
for GNSS data with a valid location fix and Velocity Valid for GNSS data with a valid location and
velocity fix.

The Clear Tracks button removes the current tracks from the map. The Fit Tracks button pans
and zooms to map so that all tracks are completely visible. The Reload button reloads the
entire map window.

The map itself can be controlled using the mouse. Click and drag to change the location of
the map. Use the scroll-wheel, shift-click and drag, or the zoom-buttons in the top-left corner
to change the zoom-level of the map. Clicking on a part of the track or on a marker shows a
popup with the GNSS information at that point.
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Figure 54: Map with GNSS track
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When switched to plot-view, the map is replaced by plots. The Plots button shows a drop-down
menu in which the several plots can be shown or hidden. The Auto-Update plots checkbox
automatically updates the plots to show newly received data. The Clear button clears all the
data in the plots.

A node needs to have a GNSS fix before data can be shown. The time on the X-axis is the
UTC-time received from the GNSS converted to local time. The specific GNSS data needs to
be enabled to be able to show it, as described in Section 4.8.8. Also Date & Time need to be
enabled.

The following GNSS items are available:

¢ Latitude geographic coordinate in degrees that specifies the north—south position.
* Longitude geographic coordinate in degrees that specifies the east-west position.
e Altitude (Ellipsoid) distance in meters above the reference ellipsoid.

¢ Altitude (Mean Sea Level) distance in meters above the mean sea level.

e Speed over Ground the ground-speed in m/s.

e Course over Ground the ground-course in degrees.

* Number of Satellites the number of satellites used in the GNSS-fix.

¢ Horizontal Dilution of Precision indication for measurement precision.

e Horizontal Position Error estimation of the horizontal position error in meters.

o Vertical Position Error estimation of the vertical position error in meters.

e Time Error estimation of the time error in seconds.

e Horizontal Velocity Error estimation of the horizontal velocity error in m/s.

* Navigation Valid navigation data is valid (1) or invalid (0).

e Velocity Valid velocity data is valid (1) or invalid (0).
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Figure 55: Plots with GNSS data
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4.13 Appearance and Preferences

The appearance of the plots can be changed via the Preferences and the Layout Configuration
windows. The following sections present the configuration options of both windows in detail.

4.13.1 Layout Configuration

The Layout Configuration window is accessible from the toolbar and via the menu View, item
Layout Wizard. Section 4.13.1 describes how this option can be used to change the type and
number of plots that are shown in the main screen.

The layout wizard makes it easy to quickly switch between layouts, or to make a custom screen
layout. Simply select one of the predefined layouts from the list and press the Finish button.
The relevant layouts for ProMove-V are:

¢ 9D: Plots of the accelerometer, compass and gyroscope sensors for all three axes.

e 9D+: Plots of the accelerometer, compass, gyroscope and high-g accelerometer sensors
for all three axes, and plots for the pressure, battery, temperature and RSSI measure-
ments.

e Empty Screen: No plots are shown.

e Custom Layout: The number of plots, the type of sensor data and the location on the
main screen can be chosen by the user.

Figure 56 shows the layout wizard set for Custom Layout. A custom layout can be created either
by modifying the number of visible rows and columns or by changing the plot type using the
Change button.

In the latter case, the Plot Selection window appears, allowing the selection of a different plot
type. When the Only show available sensors selection box is checked, the window shows only
the available sensor types of the connected nodes. Otherwise, the window shows all the avail-
able plot types.

Processed data can also be shown in the plots. Available options include the following:
¢ Norm: The normalized value of the axes of a 3D sensor (i.e. v/x* + y? + 22).

¢ Orientation: The orientation of the node, in terms of Euler angles (i.e. roll, pitch and
yaw, including FFT values) or quaternions.

¢ FFT: The Fast Fourier Transform, which can be applied to raw sensor signals or processed
data (see Section 4.13 for changing the FFT settings).

The Y-axis label of each plot can be modified, with the constraint that it must be unique. By
pressing the yellow arrow, the label resets to its default value.
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4.13.2 Preferences

The Preferences window is accessible from the toolbar and via the menu Configuration, item
Preferences. The four tabs of the Preferences window are described in the following sections.
After any modification of the preferences, press the Apply button to apply them. Press the
Close button to discard all changes.

4.13.2.1 Global

In the Global tab, the following preferences can be edited:

Small Icons in Legend: Shows small or large iconsin the
legend.

Automatically Check for Updates: Checks every week
if a new version of Inertia Studio is available.

Store Sensor Settings Automatically: Automatically
stores the sensor settings permanently on the node(s),
15 seconds after applying.

Automatically Open Export Window: Open the Export
Logfiles window (see Section 4.6 when an Export starts.
Show Network Adapters: Shows the network adapters
that can be used to connect to an Advanced Inertia
Gateway via Ethernet.

Down Sampling: A number of samples can be averaged
before showing them in the plot. This improves perfor-
mance, but shows a flattened signal. Down sampling
cannot be applied to FFT plots and has no effect on the
values in the log files.

Sample Loss Interval (s): Sets the interval in seconds
used for the accumulation of lost samples and calcula-
tion of the sample loss percentage, shown in the leg-
end.

Plot History (s): Sets the maximum number of seconds
of data to show in the plot (visible when panning the
plot).

Appearance: Selects the appearance of the screen -
Light, Dark or System.

Register File Extensions: Registers the itlog and fwu
(firmware update file) file extensions to Inertia Studio.

Preferences

Tracker
Plot

|_J Small lcons in Legend

8 Automatically Check for Updates
Store Sensor Settings Automatically
] Automatically Open Export Window
Show Metwork Adapters

Down Sampling None 5

Sample Loss Interval (s) 1
Plot Histery (s) 120
Appearance Light

Register File Extensions

Apply Close

FFT
Node

Averaging

alv| 4l

Figure 57: Global Prefer-

ences
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4.13.2.2 Plot
In the Plot tab, the following preferences can be edited:

Auto Scaling on Y-axis: Automatically adapts the limits of the Y-axis to the minimum and
maximum value of each plot.

Show Minutes on X-axis: Use minutes for the X-axis timestamp, instead of only seconds.
Show X-axis Grid: Shows grid lines on the X-axis (vertical lines).

Show Y-axis Grid: Shows grid lines on the Y-axis (horizontal lines).

Enable Anti-Aliasing: Enables anti-aliasing to smoothen the plots.

Show Gaps when Samples are Lost: When samples are lost, show a gap in the plot
instead of connecting the points directly.

Multi-Threaded Rendering: Uses multiple threads to render the plots.

Hardware Acceleration: Uses the graphics card of the PC to draw the lines in the plots.
Select which rendering method to use.

Background Colour: Changes the colour theme to a black background with white axes,
or a white background with black axes.

Update Speed: Modifies the speed at which the plots are updated. Setting the slider
closer to Slow increases the performance on a slow or overloaded PC (e.g. when showing
many plots or many nodes).

Preferences *

Crientation Tracker FFT
Global : ; Node

B Auto Scaling on Y-axis

Show Minutes on X-axis

[C) Show X-axis Grid

@ Show Y-axis Grid

[ Enable Anti-Aliasing

Show Gaps when Samples are Lost
Multi-Threaded Rendering

Hardware Acceleration  GDI+ w

Background Colour Dark w

UpdaieSpesc Fast 50ms Slow
Apply Close

Figure 58: Plot Preferences
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4.13.2.3 Node
In the Node tab, the following preferences can be edited:

¢ Node number: Selects a node number for changing its preferences.

¢ Description: A description of the selected node that will be shown in the legend. The
yellow arrow will clear the description.

¢ Line colour: Selects the colour to use in the plots for the selected node. The yellow
arrow will reset the colour to the nodes default colour.

¢ Reset for All Nodes: Resets the colour and description of all nodes to their default values.

Preferences X
Orientation Tracker FFT
Global Plot Nede
Mode Mumber 6 (ProMove-V GNSS) v
Description
Line Colour ]

Reset for All Modes

Apply Close

Figure 59: Node Preferences
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4.13.2.4 Orientation
In the Orientation tab, the following preferences can be edited:

¢ Enable Orientation Calculation: Enables calculating the orientation.
¢ Use Compass: Uses data from the compass for orientation calculation.

¢ Reduce Yaw Drift in Rest: Reduce the yaw-drift when the gyroscope is in rest (all axes at
0). Very small measurements will be ignored.

* Reset Orientation in Rest: Resets the orientation when the node stops rotating.
¢ Initial Yaw Angle (°): Sets the initial yaw angle (irrelevant when compass is enabled).
¢ Algorithm: Select the algorithm to use to calculate the orientation quaternions.

e Parameters: Opens a dialog to modify the parameters of the orientation algorithms.

Preferences >
Global Plot MNode
Orientation Tracker FFT

Enable Orientation Calculation
Use Compass

[C] Reset Orientation in Rest

Initial Yaw Angle () 0

Algorithm Valenti ~

Parameters

Gyroscope Drift
Bias Estimation

Configure

Apply Close

Figure 60: Orientation Preferences
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4.13.2.5 Tracker
In the Tracker tab, the following preferences can be edited:

¢ Show Node Numbers: Shows the node number next to the 3D model.

e Show Angles: Shows the Euler angles (roll, pitch, yaw) in the tracker. In the Tracker
window, only one node should be selected.

¢ Show Wireframe: Shows the 3D model as a wireframe.
e Show Axes: Shows the axes of the ground plane.

e Use Custom Model: Chooses a custom 3D model to show instead of the ProMove-V
model. The model should be in Wavefront .obj format®. After loading, the 3D model is
centered and scaled to fit in the tracker.

e Background Colour: Changes or resets the background colour of the tracker.

* Model Size: Increases or decreases the size of the 3D model.

Preferences W
Global Plot Mode
Orientation Tracker EFT

Show Node Numbers

Show Angles
] Show Wireframe
] Show Axes

PromoveV.obj

Model Size |

Apply Close

Figure 61: Tracker Preferences

1The .obj file should start with three-coordinate vertices followed by three-elements faces. The easiest
method to create these files is using MeshLab. First, open or import the model. Then go to the File menu and se-
lect Export Mesh (As).... Select Alias Wavefront Object (*.0bj) as filetype. In the next window, deselect everything
(or select None) and press OK.
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4.13.2.6 FFT
In the FFT tab, the following preferences can be edited:

Window Function: Selects the window function used by the FFT algorithm. The available
options are: Rectangular, Triangular, Hamming, Hanning and Blackman.

X-axis Scale: Selects the scale of the X-axis as a linear or a logarithmic scale (in decibel).
Y-axis Scale: Selects the scale of the Y-axis as a linear or a logarithmic scale (in decibel).
FFT Points (2/): The number of samples used as input for a FFT calculation (2FFT Points),
FFT Interval (s): The time in seconds between subsequent FFT calculations.

Remove DC: Reduce the 0-component by removing the mean DC signal.

FFT Averaging: The number of FFTs to average when plotting.

Preferences *
Global Plot Mode
Orientation Tracker FFT

Window Function

X-axis Scale Linear ~
Y-axis Scale Linear w
FFT Points (2] 12 =
FFT Interval (s) 0.5
Remowve DiC
FFT Averaging 1

Apply Close

Figure 62: FFT Preferences
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4.14 Updating the Firmware

The firmware can be updated for all the Inertia devices (e.g. the Inertia Gateway and ProMove-
V sensor nodes). The firmware is available for download from the Downloads page of the
Inertia Technology website: https://inertia-technology.com/downloads/.

The firmware can be updated either using USB or wirelessly.

The Firmware Update window can be accessed from the Help menu (Figure 63). Available de-
vices are listed on the left, from current and previously opened connections. The icon indicates
if a device is connected via USB or wirelessly. When available via both, the USB connection is
used. Use the refresh button in the bottom left to clear the connections and devices from the
list and refill it with currently opened connections and available devices.

Information about the selected device, including its hardware type, current firmware version,
and optional build options is shown in the Information box. When a firmware update file
(*.fwu) is selected, its targeted hardware type and firmware version is shown as well.

Use the Details button to show more information about the device and firmware file, such as
hardware revision and a list of firmware components.

Firmware Update X
com3 Node 53
a 54 C:\Temp\promowve-v_P0042-v1.7.0_master.fwu Browse
: fom“ Information
L B
H >3 Device ProMove-V (0042)
v com7
5 1.6.2 branch=master
| 103 (Gateway)
L= File ProMove-V (0042)
il | 53
uild 1.7.0
Details
Progress
Validating... oK
Upleading...

Reprogramming...

Options
[] Reset to Factory Defaults
@ validate Firmware D Hardware ID Hardware Rev.

Reprogram Close

Figure 63: Firmware Update

If no firmware is selected, the device can be reset to its factory defaults by checking Reset to
Factory Defaults and pressing Reset. After resetting, the device has to be manually restarted
for the changes to take effect.
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The Progress box shows information about validating, uploading and reprogramming. When
a node is connected and a file selected, Validating... shows whether the file is valid and if
the supported hardware matches the connected hardware. If valid, the Reprogram button
becomes enabled. Once the button is pressed, Uploading... shows the progress of uploading
the firmware to the device. If the upload is successful, the device disconnects and updates the
firmware while a Reprogramming... countdown timer is shown. When finished, the device
reboots and reconnects, and the new firmware information appears in the Information box.
Only one device per connection can be updated at once, while others will be queued.

Do not disconnect or turn off the device during reprogramming!

Reset to Factory Defaults clears the current settings and loads the default settings of the new
firmware once reprogramming is finished. This reset can also be forced by the firmware update
file. In this case, the checkbox cannot be modified. Firmware validation can be disabled to
allow programming an unsupported firmware. This could disable the device and should only
be done when instructed to do so.

If the firmware update resets the sensor settings, the wireless channel is also reset to the
factory settings. After a successful update, if the gateway and the sensor node are on different
wireless channels, the sensor node becomes unreachable. For changing the wireless channel
of an Inertia device, see Section 4.8.1.

Firmware update does not work if the device does not have internal flash memory, if the inter-
nal flash memory is full or (for older firmware) when the maximum number of files is reached.
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5 The Orientation Algorithm

The orientation algorithm uses inertial sensor data (accelerometer and gyroscope, optionally
compass) to calculate the orientation of a node. This is represented in quaternions and Euler
angles. The initial roll and pitch angles relative to the Earth’s gravitational field are instanta-
neously determined using the accelerometer. The yaw angle relative the Earth’s magnetic field
is determined by the compass. If the compass is not enabled, the initial yaw provided in para-
graph 4.13.2.4 is used. Every new inertial sample is combined with the current orientation to
calculate the new orientation. The order for Euler angle rotations is ZYX.

For the best performance, the accelerometer and compass should be calibrated as described
in Section 4.9. An uncalibrated accelerometer can cause a slight change in the roll or pitch
angles while the node is lying flat. An uncalibrated compass can cause an incorrect yaw angle
or strange jumps in the yaw angle.

There are two situations that have to be considered with respect to the usage of the compass:

* The compass is used. Please note that the compass is highly influenced by the surrounding
metal objects and electromagnetic fields and therefore it is in general not useful indoors.
To be used indoors, the node has to be at least one meter away from any metal object
and elevated at least one meter from the ground. In this case, the compass needs to be
calibrated (see Section 4.9).

e The compass is not used. In this case, the nodes start with the same initial yaw angle, which
can be configured from Preferences -> Orientation (paragraph 4.13.2.4). The computation
of the orientation using the compass has to be disabled. There are two options for doing
this:

— Deselect the option Use compass from Preferences -> Orientation (paragraph 4.13.2.4).
— Disable the compass sensor from Sensor Settings (Section 4.8.3).

At the beginning of an experiment, it is recommended to reset the initial orientation of the
algorithm by using the Reset button in the Tracker window (Section 4.11). In this way, all nodes
will start with the correct initial yaw angle.
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6 Performing an Experiment

This section describes how to perform an experiment and how to read and align the data ob-
tained from the experiment.

6.1 Experiment Preparation

In order to perform an experiment and to collect data synchronized from multiple nodes, the
following steps should be followed:

Connect the gateway (Section 4.2).
Check the settings of the gateway (Section 4.8.1).

Turn on the nodes and verify that data is received from all of them (make sure they are
on the same channel as the gateway); verify packet loss and battery level in the legend
(paragraph 4.1.3.2).

Let the nodes warm up and adjust to the ambient temperature in order to reduce the effect
of temperature changes on the sensor data.

Check the settings of the nodes regarding enabled sensors and sampling rates (Section 4.8).
Calibrate the sensors if necessary (Section 4.9).

Reset the orientation using the Reset button in the Tracker (Section 4.11). In this way, all
nodes will start with the correct initial yaw angle.

If logging to flash is required (e.g. when filling in lost samples), check the already existing
flash logs and perform a format for each node if necessary (Section 4.4.3).

Open the Logging Configuration window and check the settings regarding location of file
and other options (Section 4.3)

If Export is enabled, check the export settings (Section 4.6) and file settings, e.g. CSV Settings
(Section 4.6.1).

Start recording from Logging Configuration window or from the toolbar.

Stop recording from Logging Configuration window or from the toolbar; this step is not
necessary if a countdown timer was used (Section 4.3).

If enabled, confirm and wait for lost samples to be filled in (Section 4.5). In case of missing
data (red sections appear in the progress bar), expand the manual settings and press Start
to restart the process (Section 4.5.2).

If enabled, wait for file to be exported (Section 4.6).
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6.2 Reading and Aligning CSV Log Files

Each line in the log file consists of a timestamp and sensor data sampled at that timestamp. A
timestamp is the time in decimal seconds since the gateway was started. Figure 64 shows an
example log file containing timestamps and sensor data from an experiment.

timestamp node-id lostSamples  ax ay az rssi
183.48 23 o 0.244209 -0.174777 10.1993 -52
183.485 23 0 0.258574 -0.181959 10,1921 -52
133.49 23 o 0.237026 -0.179565 10.1873 -52
183.495 23 o 0.253785 -0.169988 10.2017 -52
183.5 23 0 0.241814 -0.189142 10.1825 -52

Figure 64: Example of a log file

Itis important to align the data from multiple nodes based on the timestamps. In a plot show-
ing sensor data from multiple nodes, the timestamps should always represent the x axis. Fig-
ure 65 shows an example of acceleration data from multiple nodes aligned based on time-
stamps.

Please note that logs from multiple nodes can have different number of samples because the
nodes could have started and stopped at slightly different times, they could have different
sampling rates, there are lost samples, etc. This is not important, as long as the sensor data is
aligned based on the timestamps.
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Aligned acceleration data from multiple nodes
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Figure 65: Example of aligned data from multiple nodes based on timestamps
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7 Troubleshooting

7.1 Green LED blinks during charging

If the green LED starts blinking during charging, the sensor node does not charge properly.
Connect the node to your computer with the USB cable. Press the button to turn the node on
and then press it again to turn it off. If the green LED is still blinking, try again the power on
and off sequence. If the device does not respond to button press, please see Section 7.2.

7.2 Unresponsive Device

If the device does not respond to button press, force the device to turn off by pressing and
holding the button for at least 10 seconds.

7.3 Retrieving an Unreachable Device

If during network reconfiguration the communication with one device is lost and reconnec-
tion is not possible using the procedures described earlier in this manual, please refer to the
following steps for device recovery:

1. Connect the device directly to the computer with a USB cable.

2. Click the Capture item from the File menu and select the serial port associated with the
device from the drop-down list. Press the Start button.

3. Open the Configuration window from the Options menu and select Global in the sensor
tree (see Section 4.8.1). Check the channel number. Change the channel if this doesn’t
match the configuration of the gateway. Transmit Data must be enabled for this node.
A mismatch of the sampling rate can also result in sensor data missing in Inertia Studio.
Note that unless the transmit type is set to USB, the data cannot be captured and shown
directly from a wired device.

7.4 Slow Signals in Inertia Studio

When using multiple nodes, it is possible that the signals in Inertia Studio are displayed slower,
and the software may start to lag. This is likely to be caused by drawing the plots, which is quite
CPU-intensive. The following options are available to increase the performance.

7.4.1 Lowering the Plot Update Speed

The Update Speed of the signals in Inertia Studio can be lowered and the averaging for the
Down Sampling can be increased, as described in paragraph 4.13.2.1 and paragraph 4.13.2.2.
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7.4.2 Reducing the Number of Plots or Nodes

The layout wizard can be used the decrease the number of shown plots (see Section 4.13.1).
Decreasing the number of plots lowers the load on the CPU. Reducing the number of nodes
that are plotted at once (see Figure 4.1.1) can also improve performance.

7.4.3 Enabling Hardware Acceleration and Multi-threaded Rendering

Enabling hardware acceleration (see paragraph 4.13.2.2) will, in general, improve the perfor-
mance by delegating some of the calculations to the GPU. Using multiple threads to render the
plots reduces the load of the main thread and improves responsiveness of the user interface.

7.5

Manually Installing the Inertia Driver

If you are unable to install the Inertia Driver via the provided installer, the driver can be installed
manually. The following steps describe this procedure for Windows.

1.
2.

Connect the Inertia device to the PC. Windows tries to find the correct driver, but fails.

Open the Device Manager from the Start Menu or Control Panel. Go to the Universal
Serial Bus controllers section (ignore the faulty devices in Other devices and Ports (COM
& LPT)).

. Select and double click USB Composite Device. Verify it is the correct one. Go to the

Details tab and select the Hardware IDs property. The value should contain
USB\VID_16D0&PID_090E.

Go to the Driver tab and select Update Driver.

Select '‘Browse my computer for drivers’, then select ’Let me pick from a list of available
drivers on my computer’.

A list with compatible hardware is shown. If it contains the latest Inertia Driver, select it.
Otherwise, select Have Disk... and browse to the location containing inertia.inf. Select
OK and Next.

. The driver is now installed. The USB Composite Device and the faulty devices in Other

devices and Ports (COM & LPT) should disapear, and an Inertia Device will appear in the
Ports (COM & LPT) section.
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